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Introduction

The Brother mobile printer, models PJ-623 and PJ-663 (with Bluetooth) are compatible with many Windows® 

and Macintosh® software applications, enabling you to print a full A4, letter or legal size document almost 
anywhere you need to work. The printers are also compatible with many mobile devices, printing plain text or 
formatted text from custom printing applications. The printers also come with P-touch Editor, a fully featured 
document design and layout software application which can help you create custom forms and templates, 
and save them to the printer’s memory. This guide will show you how to download and manage these files 
using P-touch Transfer Manager and P-touch Library.

Important Notice

 The contents of this document and the specifications of this product are subject to change without notice.

 Brother reserves the right to make changes without notice in the specifications and materials contained 
herein and shall not be responsible for any damages (including consequential) caused by reliance on the 
materials presented, including but not limited to typographical and other errors relating to the publications.

 Screen images in this document may differ depending on your computer's operating system and your 
product model.

 Before using the printer, be sure to read all documents included with the printer for information about safety 
and correct operation.

Symbols used in this document

The following symbols are used throughout this document.

About this document

This document (PDF) is included on the CD-ROM.

Note

If using Adobe® Reader® to view this document on a computer, the cursor changes to  when the cursor 
is placed on a link. Click the link to open the corresponding page. For information about using 

Adobe® Reader®, see the help file included with Adobe® Reader®.
 

 This symbol indicates information or directions that should be followed. Ignoring them may result in 
damage, or failed operations.

 This symbol indicates notes that provide information or directions that will give a better understanding 
and help to use the product more efficiently.
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P-touch Editor allows you to create templates with various kinds of designs. 
Refer to the P-touch Editor help file for template design samples and details on creating, printing, and saving 
your templates.

To download the latest driver and software, please visit the Brother Solutions Center website: 
http://solutions.brother.com

Installing P-touch Editor Software 1

a Insert the CD-ROM into your computer’s CD-ROM drive.
 

b Click [PC (Windows) software], and then click [P-touch Editor 5.0].

c Follow the on-screen instructions to install the software.

d Click [Finish] to close the installation screen.

How to install/uninstall P-touch Editor 
Software 1

Certain functions cannot be used if the printer driver is not installed. 
For details about installing the printer driver, refer to the User’s Guide.

http://solutions.brother.com
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Uninstalling P-touch Editor Software 1

a For Windows® XP:
From [Control Panel], go to [Add or Remove Programs].
The [Add or Remove Programs] dialogue box appears.

For Windows Vista® / Windows® 7:
From [Control Panel], go to [Programs] and open [Programs and Features].
The [Uninstall or change a program] dialogue box appears.

b Choose [Brother P-touch Editor 5.0], and click [Remove] (XP) / [Uninstall] 
(Windows Vista® / Windows® 7).

c Click [OK].
The uninstall operation starts. After the software is removed from your computer, the 
[Maintenance Complete] dialogue box appears.

d Close the [Add or Remove Programs] (XP) / [Programs and Features] 
(Windows Vista® / Windows® 7) dialogue box.
P-touch Editor / P-touch Update Software has been uninstalled.
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The following explanations and procedures depict Windows Vista®, and may vary depending on your 
computer’s operating system. In the screen shots, “XX-XXXX” is displayed to represent the printer model 
number.

Using P-touch Editor 2

Starting P-touch Editor 2

a Click [Start]-[All Programs]-[Brother P-touch]-[P-touch Editor 5.0].
 

When P-touch Editor starts, the [New/Open] dialogue box is displayed. This dialogue box allows you to 
select whether you want to create a new template or open an existing template.

Note
• You can also start P-touch Editor using shortcuts, if you selected to create shortcuts during installation.

• Shortcut icon on the desktop: double-click to start P-touch Editor

• Shortcut icon in the Quick Launch bar: click to start P-touch Editor

• To change how P-touch Editor functions when it starts, click [Tools]-[Options] in the P-touch Editor menu 
bar to display the [Options] dialogue box. In the [General] tab, select the desired setting in the 
[Operations] list box under the [Startup Settings]. Normally, [Display New/Open Dialogue Box] will be 
selected.

 

How to use P-touch Editor 2
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b Select an option in the [New/Open] dialogue box and click [OK].
 

 The printer and media size can be selected in this dialogue box.

 Click [Open File] to display the [Open] dialogue box, where you can select and open a previously 
saved template.

 Click [View History] to open the [History] dialogue box, where you can select and open recently 
saved templates.

 Click [New] to select the desired orientation (vertical or horizontal) and create a new template.

 Click [Select by Use] to create a new template based on how it will be used.

 Click [Help - How To] to view the P-touch Editor help file. 
The help file shows you step-by-step how to create a template.

 Click [Check for Updates] to look for a newer version of P-touch Editor online. If a newer version is 
available, the computer’s web browser will open the Brother Solutions Center website, where you can 
download the latest version.
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Operation modes 2

P-touch Editor has three different operation modes: [Express] mode, [Professional] mode, and [Snap] 
mode. You can easily switch between modes by using the mode selection buttons.

 [Express] mode

This mode allows you to quickly and easily create templates that include text and images. 
The [Express] mode screen is explained below.
 

1 Menu bar
Provides access to all available commands, which are grouped under each menu title ([File], [Edit], 
[View], and [Insert], etc.) according to their functions.

2 Command bar

Provides access to frequently used commands, such as [New/Open], [Paper], [Text], [Frame], 
[Image], etc.

3 Draw/Edit toolbar
Provides tools for selecting objects, entering text, drawing graphics, etc.

4 Property bar

Allows you to edit the properties of text, graphics, etc.

5 Template window

Provides the area where you create and edit your templates.

6 Database window
Displays the content of a connected database or label list that can be used to add content to your 
templates.

7 Mode selection buttons

Allows you to switch to another operation mode.

Note
• You can show and hide different toolbars and windows using the commands in the [View] menu.

• For details about using [Express] mode, refer to the P-touch Editor help file.
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 [Professional] mode

This mode allows you to create templates using a wide-range of advanced tools and options. 
The [Professional] mode screen is explained below.
 

1 Menu bar

Provides access to all available commands, which are grouped under each menu title ([File], [Edit], 
[View], and [Insert], etc.) according to their functions.

2 Standard toolbar
Provides access to frequently used commands, such as New Layout, Open, Save, Print, etc.

3 Property palette

Provides access to the Print, Paper, Text, and Layout palettes. Click on the left side of each palette to 
show/hide the available properties.

4 Draw/Edit toolbar
Provides tools for selecting objects, entering text, drawing graphics, etc.

5 Template window

Provides the area where you create and edit your templates.

6 Database window

Displays the content of a connected database or label list that can be used to add content to your 
templates.

7 Mode selection buttons
Allows you to switch to another operation mode.

8 Side bar

Provides access to different tabs that allow you to insert and format text, bar codes, tables, etc., change 
the order of the objects to create a template, or set advanced settings.

Note

• You can show and hide different toolbars and windows using the commands in the [View] menu.

• For details about using [Professional] mode, refer to the P-touch Editor help file.
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 [Snap] mode

This mode allows you to capture all or a portion of your computer screen content, print it as an image, and 
save it for future use.

a Click the [Snap] mode selection button. The [Description of Snap mode] dialogue box is displayed.
 

b Click [OK]. The [Snap] mode palette is displayed.
 

Note
• If you select the [Do Not Display This Dialogue Again] check box in the [Description of Snap mode] 

dialogue box, you switch to [Snap] mode next time without displaying the dialogue box.

• You can also start P-touch Editor in [Snap] mode by clicking [Start]-[All Programs]-[Brother P-touch]-
[P-touch Editor 5.0 (Snap mode)].

• For details about using [Snap] mode, refer to the P-touch Editor help file.
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Using P-touch Editor Help 2

Viewing the P-touch Editor help file 2

This section explains how to use the P-touch Editor help file.

Starting from the [Start] menu 2

Click [Start]-[All Programs]-[Brother P-touch]-[P-touch Editor 5.0 Help].
 

Starting from the [New/Open] dialogue box 2

When you start P-touch Editor and the [New/Open] dialogue box is displayed, click [Help - How To].
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Starting from P-touch Editor 2

 In [Express] mode or [Professional] mode:

Click the [Help] menu and select [P-touch Editor Help].

[Express] mode  2

[Professional] mode 2

 In [Snap] mode:

Place the mouse pointer within the [Snap] mode palette so that the four-way arrow pointer (the “move” 
pointer) is displayed, right click and then select [P-touch Editor Help].

[Snap] mode  2

Note

You can also press the [F1] key to open the P-touch Editor help file.
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Printing the P-touch Editor help file 2

You can print P-touch Editor help file content for later reference.

a In the [Contents] tab, select the content that you want to print.

b Click [Print] on the Toolbar.

c Choose the range of topics to be printed, and click [OK].
 

d Specify the [Printer] and click [Print].
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P-touch Transfer Manager 3

This program allows you to transfer templates and other data to the printer and save backups of your data on 
the computer.

After P-touch Transfer Manager is used to transfer data to the printer, P-touch Template is used to send text 
data to the printer that will be inserted into the template and printed. For details on P-touch Template, 
download the P-touch Template manual (English only) from the Brother Solutions Center website: 
http://solutions.brother.com 
Select your region and your country. Then choose your product and click on [Manuals].

P-touch Library 3

This program allows you to use your computer to manage P-touch templates and other data. 
You can use P-touch Library to print templates.

Using P-touch Transfer Manager 3

Starting P-touch Transfer Manager 3

Click [Start]-[All Programs]-[Brother P-touch]-[P-touch Tools]-[P-touch Transfer Manager 2.1]. 
When P-touch Transfer Manager starts, the main window is displayed.

Note
You can also start P-touch Transfer Manager from P-touch Editor.

Click [File]-[Transfer Template].
 

How to use P-touch Transfer Manager & 
P-touch Library 3

http://solutions.brother.com
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Main window 3

 

1 Menu bar
Provides access to various commands, which are grouped under each menu title ([File], [Edit], [View], 
[Tool], and [Help]) according to their functions.

2 Toolbar

Provides access to frequently used commands.

3 Printer selector
Allows you to select which printer the data will be transferred to. When you select a printer, only the data 
that can be sent to the selected printer is displayed in the data list.

4 Folder list

Displays a list of folders and printers. When you select a folder, the templates in the selected folder are 
displayed in the template list.
If you select a printer, the current templates and other data stored in the printer are displayed.

5 Template list

Displays a list of templates in the selected folder.

6 Preview

Displays a preview of the templates in the templates list.

2
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Transferring templates or other data from the computer to the printer 3

Use the following procedure to transfer templates from the computer to the printer.

a Connect the computer and the printer via USB and turn on the printer.
The printer model name is displayed in the folder list.
If you select a printer in the folder list, the current templates and other data stored in the printer are 
displayed.

b Select the printer that you want to transfer the template or other data to.
 

Explanations of the Toolbar Icons

Icon Button name Function
 

Transfer
Transfers templates and other data from the computer to the printer 
(available for USB connection only).

 

Backup
Retrieves the templates and other data saved in the printer and 
saves it on the computer (available for USB connection only).

 

Open Opens the selected template.

 

Search
Allows you to search for templates or other data that are stored in 
the P-touch Library.

 

Display Style Changes the file display style.

This feature is only available when the computer and printer are connected via USB.



How to use P-touch Transfer Manager & P-touch Library 

14

3

c Right-click the [Configurations] folder, select [New], and then create a new folder.
 

In the example above, the folder [Transfer] was created.

d Drag the template or other data that you want to transfer and place it in the new folder.

You can browse for templates or other data by selecting [All Contents] or by selecting one of the 
categories under [Filter], such as [Layouts].

When transferring multiple templates or other data, drag all the files that you want to transfer and place 
them in the new folder.

Each file is assigned a key number (memory location in the printer) when it is placed in the new folder.
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e To change the key number assigned to an item, right-click the item, select [Key Assign], and then select 
the desired key number.
 

Note

• All data transferred to the printer is assigned a key number.

• If the template or other data transferred to the printer has the same key number as another template 
already saved in the printer, the new template will overwrite the old one. You can confirm the templates 
key number assignments saved in the printer by backing up the templates or other data (see Backing up 
templates or other data saved in the printer on page 17).

• If the printer memory is full, remove one or more templates from the printer’s memory. (see Backing up 
templates or other data saved in the printer on page 17).

 

f To change the names of templates or other data that will be transferred, click on the desired item and 
enter the new name. The number of characters used for the template names may be limited depending 
on the printer model.
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g Select the folder containing the templates or other data that you want to transfer, and then click 
[Transfer]. A confirmation message will be displayed.
 

Note

• You can also transfer individual items to the printer without adding them to a folder. Select the template or 
other data that you want to transfer, and then click [Transfer].

• Multiple items and folders can be selected and transferred in one operation.
 

h Click [OK].
 

The selected templates, folders or other data are transferred to the printer.
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Backing up templates or other data saved in the printer 3

Use the following procedure to retrieve the templates or other data saved in the printer and save it on the 
computer.

a Connect the computer and the printer via USB and turn on the printer.
The printer model name is displayed in the folder list.
If you select a printer in the folder list, the current templates and other data stored in the printer are 
displayed.

b Select the printer to back up from, and then click [Backup].
A confirmation message is displayed.
 

c Click [OK].
A new folder is created under the printer in the folder list. The folder name is based on the date and time 
of the backup. All of the printer's templates and other data are transferred to the new folder and saved 
on the computer.
 

 This feature is only available when the computer and printer are connected via USB.

 Backed up templates or other data cannot be edited on the computer.

 Depending on the printer model, templates or other data backed up from one printer model may not be able 
to be transferred to another printer model.
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Deleting all data saved in the printer 3

Use the following procedure to delete all templates or other data that are saved in the printer.

a Connect the computer and the printer via USB and turn on the printer.
The printer model name is displayed in the folder list.

b Right-click the printer, and then select [All Delete].
 

A confirmation message is displayed.
 

c Click [OK].
All templates and other data saved in the printer are deleted.

This feature is only available when the computer and printer are connected via USB.



How to use P-touch Transfer Manager & P-touch Library 

19

3

Using P-touch Library 3

Starting P-touch Library 3

Click [Start]-[All Programs]-[Brother P-touch]-[P-touch Tools]-[P-touch Library 2.1].
When P-touch Library starts, the main window is displayed.

Main window 3

 

1 Menu bar
Provides access to all available commands, which are grouped under each menu title ([File], [Edit], 
[View], [Tool], and [Help]) according to their functions.

2 Toolbar

Provides access to frequently used commands.

3 Folder list

Displays a list of folders. When you select a folder, the templates or other data in the selected folder is 
displayed in the templates list.

4 Templates list
Displays a list of the templates or other data in the selected folder.

5 Preview

Displays a preview of the templates or other data selected in the templates list.

2

3
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4
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Opening and editing templates 3

Select the template you want to open or edit, and then click [Open].
 

The program that is associated with the template will be started and you can edit the template.

Note
The program that starts depends on the type of file that is selected. For example, if you select a P-touch 
template, P-touch Editor starts.

 

Explanations of the Toolbar Icons

Icon Button name Function
 

Open Opens the selected template.

 

Print Prints the selected template.

 

Search
Allows you to search for templates or other data that are stored in 
the P-touch Library.

 

Display Style Changes the file display style.
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Printing templates 3

Select the template that you want to print and then click [Print].
 

The template is printed using the connected printer.

Searching for templates or other data 3

You can search for templates or other data registered to P-touch Library.

a Click [Search].
The [Search] dialogue box is displayed.
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b Specify the search criteria.
The following search criteria are available.

c Click [Begin Search].
The search begins.
 

d Close the [Search] dialogue box.
The search results can be confirmed by clicking [Search Results] in the folder list.

Note
You can register templates or other data to P-touch Library by dragging and dropping the files to the 
[All Contents] folder or to the folder list. You can also configure P-touch Editor to register templates to 
P-touch Library automatically, using the following procedure.

1 From the P-touch Editor menu, select [Tools]-[Options].

2 In the [Options] dialogue box, click [Registration Settings] in the [General] tab.

3 Select the timing for registering templates created with P-touch Editor, and then click [OK].
 

Settings Details

Multiple Parameters Determines how the program searches when multiple criteria are specified. If you select 
[AND], the program searches for files that satisfy all of the criteria. 
If you select [OR], the program searches for files that satisfy any of the criteria.

Name Allows you to search for a template or other data by specifying the file name.

Type Allows you to search for a template or other data by specifying the file type.

Size Allows you to search for a template or other data by specifying the file size.

Date Allows you to search for a template or other data by specifying the file date.
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